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Introduzione

e Ambiente avanzato di calcolo numerico

— Linguaggio di programmazione

e Supporto a GUI

« Ampiamente utilizzato in

— Ambito scientifico
— Ambito industriale

About MATLAB

MATLAB

Yersion 6.5.0.180913a Release 13
June 18, 2002

License Mumber:

)\ The MathWorks http: /Ammww.mathworks.com/
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Introduzione

o Caratteristiche

— Semplice da imparare e utilizzare
* Notazione matematica

— Approccio procedurale
« Linguaggio interpretato
« Assenza esplicita di tipi

— Incoraggia a trovare soluzioni matriciali
» Tipo base € la matrice
« Operazioni base su matrici

— Fornisce molte funzionalita
* numeriche
« grafiche

— Possibilita di interfacciamento ad altri linguaggi

Introduzione a MATLAB




Introduzione

 MATLAB e sostanzialmente un

 PSE : Problem Solving Enviroment

— Ambiente che offre funzionalita per risolvere problemi in una data area
* Image Processing Toolbox

Neural Network Toolbox

Statistics Toolbox

Financial Modeling

Signal processing

 RPE : Rapid Prototyping Environment
— Sistema per sviluppare e testare idee od algoritmi rapidamente

Introduzione a MATLAB 4




Outline

« MATLAB

— Introduzione
— Operazioni

— Visualizzazione scientifica

=P

— Programmazione

e Esempi

Filg Edit View Web window Help

@ H| B @ sewfee >

Name |Size |Bytes|Class

ccolormap gray =

colormap gray

axis off

colorbar

whoe

Whos

216

colorbar

440*440+2

440*440*2

387200/1024

3-- 5/15/05 3:28 PM --%

. |

>

O @‘ ¥ B o o ‘ o ‘ ? |CurrervtD\rEDtnl’v'ID\MASTERELAEIMMAGIN\WatIab =l J

Using Toolbox Path Cache.

To get started, select "MATLAE Help" from the Help menu.

Type "help toolbox path cache" =

4 Start
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MATLAB

<) MATLAB ol x|

Fle Edt Wiew Web Window Help _{ﬂ/ Current Directory

0O @| & B o o | .3 | ? |Current DirBCTDFYZID:\MASTER ELSB IMMAGINmatiskh

Cormmand Window

= i | & | i | Staf*:m Using Toolbox Path Cache. Type "help toolbox path cache" =
Name |Size |Bytes|Class |
To get started, select "MATLAE Help" from the Help menu.
s
Workspace l
ccolormap gray |
colormap gray
axis off Finestra di lavoro
colorbar
whoe
-
o History
colorbar
440*440+2
440*440*2
387200/1024
%-— &/15/05 3:28 PM --% |
J | oAl | o

<\ Start |
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MATLAB

e Current Directory
— Directory di lavoro
— Eventuali file vengono cercati/esequiti in questa cartella e nel path
definito (File->Set Path )
 Workspace

— Mostra informazioni relative a tutte le variabili
« attualmente in memoria
» che possono essere utilizzate nella finestra deio comandi

e History
— Mostra tutti | comandi esequiti fino a quel momento

» Se doppio click sul comando, viene eseguito
» Possibile copia/incolla

Introduzione a MATLAB




MATLAB

 Finestra di lavoro

— Consente di eseguire direttamente dei comandi MATLAB
 Interni o esterni (programmi/script MATLAB)

— Forniti comandi generici di sistema
 Is, dir, cd, delete, ...

— Programmi esterni possono essere eseguiti con “!”
Inotepad

— Permette di richiamare I'help in linea e di fare ricerche
help comando
lookfor testo

Introduzione a MATLAB




MATLAB

+) MATLAB

File Edit Miew ‘Web MWindow Help

=10l x|

0O Iﬁ:| & B < cu | ﬁ | 2 |Currer|t Diremury:lc:wATLAEEpﬁwj J

»=» help conv

C = CONV(4, B) conwolwes wectors 4 and B.
vector iz length LENGTH(4)+LENGTH(E)-1.

See also DECONW, CONVZ, CONVN, FILTER and,
Processing Toolbox, XCORR, CONVITTX.

/|

CONYV Conwvolution and polynomial multiplication.
The resulting

-l

If &4 and B are wvectors of polynomial coefficients, conwolwing
then iz equivalent to multiplying the two polynomials.

in the 3ignal

—
=

4&5tart|

File Edit YWew ‘Web MWindow Help

| T _imi x

O = | & R o o | .4 | ? |Currerrt Directory: | C:WATLABGpSwork | J

>> lookfor edge
EdgeEnh.m: % function ImmEnh=EdgeEnh (immadgine, ganma)
Edge fra.m: % InwEnh=ThresholdEdge (InnElab ,mask3kin,0.5,0) ;

&

edge_sharp adaptive.m: % function esha=edge_sharp adaptive (inmagine)
unsharp edge_adaptive.m: % function ImnEnh=unsharp edge adaptive (inmagine)
UNMESH Conwert a list of edges Lo a graph or matrix.

EDGE Find edges in intensity image.

EDGETAPER Taper the discontinuities along the image edges.

EDGEDEMO Edge detection demo.

2

d

4!-5tart|
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MATLAB

 Help-MATLAB Help

File Edit View Go Web Window | Help

_lofx|

Help Navigator

- = | = |Fi|‘idinpage.| ﬂl

Procuct fiter: & ajl © Selected  Select

Contents | IniciEs; I Search I Demos |

—[ Begin Here ]
ﬂ—@ Release Motes for Release 1
|

"¢ Installation

#-[3= Getting Started

—’Q Examples

= @ Development Environmel
F-Starting and Quitting MAT
F-lUsing the Deskiop
I'—]—R]unning MATLAR Functic
—Opening the Comma
%:Running Functions a
B-Controlling Input and
2

+—Searching in the Cor
%Running Programs
+-Preferences for the G
+-Command Histary
F-Getting Help
F-arkspace, Search Path
FE-lmporting and Exporting [
F-Editing and Debugging i
£
£

r|nterfacing with Source ©
t-1)sing Motebook
—Examples

]—@ Mathematics

J— Programming and Data T
]—% Graphics

73] 3-D visualization

Z'—% Creating Graphical User
4 | 3

T

MATLAB

@ Learning MATLAB

+ Getting Started - introduction to MATLAB.

+ Using MATLAB - user guides for all of MATLAB.

+ Programrming Tips - tips on many aspects of programming with MATLAB.
+ Exarnples - major examples in the MATLAB documentation,

+ Release Motes - summary of new features, bug fixes, upgrade issues, etc.

@ Finding Functions and Properties
+ MATLAB Functions Listed by Category - browse MATLAB functions by category.
+ MATLAB Functions Listed Alphabetically - find functions from an alphabetical list.
If you know the function name:

1. Click Search in the Help Browser's left pane
2. Select Function Name for the type of search
3. Enter the name of the function in the Search for field and click Go.

+ Handle Graphics Property Browser - view descriptions of all graphics object properties.
[ Printing the Documentation

+ Printable versions of the MATLAE documentation and related papers in PDF format.

:I Add to Favarites |

Introduzione a MATLAB
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MATLAB

e Comandi MATLAB

— Possono fare parte del linguaggio
* Funzioni matematiche, algebriche
* Risoluzione di sistemi di equazioni
« Analisi di dati

— Possono essere funzioni (script) MATLAB esterni
» File testuali con estensione .m
« Contengono uno o piu comandi
* Toolbox

Introduzione a MATLAB
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JkEMATLAB 7.3.0 {R2006b)

<5x5 double=
-0.0276

$-- 10/31/07 12:40 PN --%
~-a=rand(§, 5)
“eb=det (&)

VIATLAB

Ci\Program Files\MATLABR2006E work,

>> a=rand(5,5)

4514
L0439
L0E7E
L3127
L0129

=» h=det (&)




MATLAB

o Caratteri speciali

% commento (da usarsi nei file .m)
continuazione sulla riga successiva (da usarsi nei file .m)
~= operatore disuguaglianza
== operatore di uguaglianza
: Impedisce I'echo del comando
: separa argomenti o comandi

e Alcuni comandi

clc cancella il contenuto della finestra dei comandi

clear n cancella la variabile n dal workspace

clear cancella tutto il contenuto del workspace

close all chiude tutte le finestra secondarie di MATLAB aperte

Introduzione a MATLAB
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MATLAB

= MATLAB 7.3.0 (R2006b}
File Edit Debug Deskbop ‘Window Help

=101 x|

O = | p B« o | [~ ﬁ B | @ |Current Directory: | C:\Program Files\MATLABIR2006bwork

Shortcuks (2] How to add (2] What's Mew

sep=iny (a) det (o)

a.

-1.
2460
-0,

6124

ab65
7318

956l

Workspace LA Al Command Window
EI - | stack:| Base - :
hEH DS e | I -|stekomse -] 0 o1zs
Mame £ Ivdue
Eﬂa <5¥5 double> =» b=det {a)
M ans -36.2436
Hb -0.0276 b =
Hc <5¥5 doubles
-0.0276
>»> b=det (a);
> o=invia)  det o)
Kl | Hill e =
Command History A M _0.1872
-0.7682
2.0870
-1.6205
2.4117

7304

0.5569

-3.8779
-&.7112
3.8529
-&.a387
0.1248

@ variabile di lavoro

-36.2436

-
-

-3

-3

L BB55D
0751
L0273
4610
3540

0.1536

-0.9189
0.4761
0.4864
0.2330

-1.4035

L4]

= 1 F_-tartl

@R, 4
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MATLAB

 MATLAB non usa dichiarazione di variabili o dichiarazione di

dimensioni
— Variabili automaticamente create all’'uso

e | nomi delle variabili sono case sensitive

* Non esistono dichiarazione di tipi di dati
— Le variabili assumono automaticamente il tipo corretto

— |l dato fondamentale e la matrice rettangolare (di double)
» Variabile semplice = matrice 1x1
» Vettore riga = matrice 1xN
» Vettore colonna = matrice Nx1

Introduzione a MATLAB
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VIATLAB:

e Creare Matrici
— ones(r,c)
— zeros (r,c)
— eye(r,c)

— a=[allal2; @%;\22]
Riga

successiva
all al2

a2l az22




MATLAB: Operazioni

e Matrici
— Gli indici degli elementi partono da 1 !
- m(2,3) Terzo elemento della seconda riga
— sz=size(V) Sz e un vettore 2D con le dimensioni di v
— (Ir,c]=size(v) ‘I’ e ‘c’ conterranno separatamente le
dimensioni di v
o1 x]
v File Edit Yiew Web Window
Notazione per gestire piu valori Help
di ritorno di una funzione >> w=ones(2,4): =

= [r,c]==ize(m) ;
¢

Introduzione a MATLAB
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MATLAB: Operazioni

e Creare Vettori e Variabili

— Basta assegnarle

— |l tipo concreto della variabile si
puo conoscere con il comando

— whos nomevar

<} Command Window

File Edit Wew Web ‘Window Help

=10l x|

<} Command Window (=] S
File Edit ‘iew ‘Web window Help
>> whos b =
Name Size Ewtes Class
b 1x1 & double array
Grand total is 1 element using 8 bytes
== whos ¥
Name Size Evtes Class
v 1=3 24 double array
Grand total is 3 elements using 24 hytes
ps —
L
1 I

F> b=890, c=1le-7, d='pippo', e=10+i%*a

b =

a0

1.0000e-007

=

pippo

10,0000 + 6. 00001

e ow=[1l:2:3]

o=
1
Z
S
== v=[1l 2 3]
v o=
1 2 S|
>=

d

Variabile “intera”

Variabile “reale”

Variabile “stringa”

Variabile “complessa”

Vettore colonna

Vettore riga

|»

Introduzione a MATLAB




MATLAB: Operazioni

* Operazioni su matrici

A+B
A*B
A
A.*B

Somma / differenza di matrici
Prodotto di matrici

Trasposta di A

Esegue I'operazione * punto a punto

7 6 7 12
.* =

2 4 6 16

7 6 1 64
-/\ =

2 4 9 256

+} Command Window

Fil=  Edit ‘Wiew Webh Window Help

S [l

== w=[1 2 3 4]

o=

1 Z 3 4
= w=wr!
W
1
2
3
4
Fr WEY
ans
1 Z 3 4
2 4 & g
3 | a 1z
4 g 12 la

Fs

Introduzione a MATLAB
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MATLAB: Operazioni

e Operazioni su matrici: alcune funzioni

— det(A)
— inv(A)
— sum(A)

Determinante

Inversa
Somma delle colonne (risultato € un vettore)
(max,min,mean,std,... )

— max(max(A)) Somma degli elementi di A

— magic(N)

Genera un guadrato magico NxN

16 2 3 13

Introduzione a MATLAB
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MATLAB: Operazioni

e Operazioni su matrici: accesso a righe e colonne

6 | 2 | 3 | 13 M(/lo=162313
5 | 112 | 10 | 8
“Tutto”
M=
O | 7|6 |12 5 | 11 | 10 | 8
M )=
4 | 14 | 15 1 9 . 6 | 1o
da-a
V=| 1 8 14
5 | 11
M(2:3,1:2)=
9 7
14 | 8

N@: 16

M(:,4)=

13

12

9

13

10

14

1
2
3

5
6
7

11

15

4

8

12

16

V e usato come serie di
indici nella matrice

Introduzione a MATLAB
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MATLAB: Operazioni

e Operazioni su matrici: eliminazione di righe o colonne

16 2 3 13

16 | 2 | 3 | 13 M(2:3,)=]]

M=
9 7 6 12 16 2 13
4 14 15 1 5 11 8
M(:,3)=(]
9 7 12
4 14 1

e Svuotare (non rimuovere) una variabile: var=[]

Introduzione a MATLAB




MATLAB: Operazioni

* Operazioni su matrici: esempi

M=ceil(rand(4)*100)

47 61 88 | 100
57 6 2 79
M=
80 42 77 44
6 31 98 50

N=M+10*(not(M==0))+5.*(M==0)

57 5 5 5
5 16 12 5
N=
5 52 5 54
16 41 5 5

M(find(M>=50))=

47 0 0 0
0 6 2 0
0 42 0 44
6 31 0 0

O/1 |1 1
11001
1/0|1)]0
0O/ 0 1|1

Introduzione a MATLAB
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MATLAB: Operazioni

e Operazioni su matrici: composizione

1 2 10 | 20
A= B=
3 | 4 30 | 40 1 | 2 |10 |20
M=[A B]=
3 4 30 | 40
1 2
1 2
3 4
M=[A;B]= M=[A(1,:);[100 200];B(2,:)]= 100 | 200
10 | 20
30 | 40
30 | 40

Introduzione a MATLAB
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MATLAB: Operazioni

o Serie di valori
— Si usa l'operatore “:”

@

a=-3:2:3

a=0:pi/4:pi

— Fondamentale per creare serie del tipo y(i)=f(x(i))

Passo 1 implicito

a=l 1| 2| 3| 4|5 |6 | 7| 8] 9|10
a=|l 3 |1 | 1|3
a= 0 0.7854 1.5708 2.3562 | 3.1416

Introduzione a MATLAB
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MATLAB: Operazioni

o Serie di valori
— Si usa l'operatore “:”

x=0:pi/4:pi X= 0 0.7854 1.5708 2.3562 | 3.1416
y=sin(x) y= 0 0.7071 1.0000 0.7071 0

y=exp(x) y=| 1.0000 2.1923 4.8105 | 10.5507 |23.1407
y=exp(-(pi/2-x).~2) y=| 0.0848 0.5396 1.0000 0.5396 | 0.0848

Introduzione a MATLAB

26




MATLAB: Visualizzazione

e Uno dei punti di forza di MATLAB

e Diverse modalita di visualizzazione dei dati
— 2D, 3D, Movie,...

o Utili per
— Trovare modelli
— ldentificare tendenze
— Comparare informazioni complesse
— Esaminare dati in modo piu “visibile”

* Diverse funzionalita per manipolare gli oggetti grafici

Introduzione a MATLAB
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MATLAB: Visualizzazione

* Finestra di visualizzazione grafica

J Figure No. 1 ;lglil

File Edit “iew Insert Tools Window Help

IDdES(xA A/ 320 Strumenti Grafici
plot3(X,Y,Z)

Titoli

Finestra di visualizzazione

Introduzione a MATLAB
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MATLAB: Visualizzazione

» Le finestre grafiche vengono create
— Automaticamente da funzioni specifiche

 plot disegna una serie di dati in 2D
o plot3 disegna una serie di dati in 3D
o figure apre una finestra grafica vuota e la attiva
— figure
o figure(n) rende corrente la finestra grafica numero n
e close(n) chiude la finestra grafica numero n
 hold on continua a disegnare sulla finestra grafica corrente

Introduzione a MATLAB
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MATLAB: Visualizzazione

X=-6*pi:pi/16:6*pi

) Figure No. 1

=10l x|

y:SIn(X) File Edit Wew Insert Tools Window Help
plot(x,y) IneE& yA A/ | @poo
, Grafico
tltlE(‘GraﬂCO’) 0.8 - - - -------- ----- : :zgigi}{s)in(x+piﬂj
xlabel(*x’) MIRR - | - - :
ylabel(‘sin(x)’) »
legend(‘y=sin(x)") | | | 5 5 5 5 5
axis([-6*pi 6*pi -1 1]) _ e
£ Op-heob

hold on o
y2=0.5*sin(x+pi/2) 0
plot(x,y2,'r) 05
legend(‘y=sin(x)’,... 0.8

'y=0.5*sin(x+pi/2)") ¥ L
grid on X
Introduzione a MATLAB 30




MATLAB: Vis

Xr:|inspace(_1’1’360) J Figure No. 1
yr=sin(2*pi*xr) o

x=linspace(-1,1,3)
y=sin(2*pi*x)

subplot(2,2,1)
plot(xr,yr,'r,x,y,’b")

x=linspace(-1,1,9)
y=sin(2*pi*x)

subplot(2,2,2)
plot(xr,yr,’r’’,x,y,'b’)




MATLAB: Visualizzazione

x=linspace(-1,1,25)
y=sin(2*pi*x)

subplot(2,2,3)
plot(xr,yr,’r:’,x,y,’b’)

x=linspace(-1,1,100)
y=sin(2*pi*x)

subplot(2,2,4)
plot(xr,yr,’r:’,x,y,’b’)

~loix|
File Edt View Insert Tools Window Help
lozaa/yar  pea
1
1 2
]
]
]
|
______________ e
1
1
]
3 4
]
______________ o ____
|
|
1
1
]
5 | 6
]

J Figure No. 1

File Edit WYiew Insert Tools Window Help

=10l %]

I IR YAk

1

05|/

1]

-0.5

1
0.5 /

-0.5

subplot(3,2,5) =
Attivo quinto settore della finestra suddivisa in 3 righe e 2 colonne

Introduzione a MATLAB
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MATLAB: Visualizzazione

* Modificare simboli del grafici

x=1:20
yl=rand(1,20)
y2=rand(1,20)

plOt(X,yl,’*r")
hold on
plot(x,y2,'+b:")

File Edit “ew Insert Tools Deskkop ‘Window Help

=10l x|

D& K RaMm® €| 08 0O

0.9

0.8+

0.7+

0.6+

0.4r

03

02F

0.1F

o

0&5F +

0

Introduzione a MATLAB

33




MATLAB: Visualizzazione

e Graficl a barre

y=rand(5,3)

subplot(2,2,1)
bar(y,'grouped’)

subplot(2,2,2)
bar(y, stacked’)

subplot(2,2,3)
barh(y)

subplot(2,2,4)
bar(y,1.5)

colormap autumn

J Figure Mo, 1

File Edit Wiew Inserk Tools  Window  Help

=101 %]

Inema xar/ 220

1

0.8
0.6
0.4
0.2

25

1.5

0.5

0.8
0.6
0.4
0.2

il

Introduzione a MATLAB
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MATLAB: Visualizzazione

|l plot di una matrice viene fatto per colonna

x=linspace(-1,1,100) ) FgurcBel

File Edit ew Insert Tools bindow  Help

=10l x|

: : lDes@&a yA /| 2e0
S=sin(2*pi*x)
1

C=COS(2*pi*X) gl g
0.6+
g=exp(-((x./0.3).2)) 04}
0.2r
M=[s" ¢’ g] 0
02 F
plot(x,M); o4l
0B

05+

_1 | | | | | | | | |
-1 08 06 -04 02 1 02 04 0o 08

Introduzione a MATLAB
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MATLAB: Visualizzazione

« Disegno di una traiettoria in 3D

) Figure No. 1
File Edit Wiew Insert Tools ‘Window Help

=101 x|

: . DEEHS YA A/ 2P
t=0:pi/50:20*pi o

plot3(sin(t),cos(t),’r’)

grid on

title(‘Elica 3D’)

xlabel(*x’) i
ylabel('y’)

zlabel('t")

Introduzione a MATLAB

36




MATLAB: Visualizzazione

e Se si plottano in 3D matrici, si ottengono le linee
corrispondenti alle colonne delle matrici

J Figure MNo. 1
File Edit “iew Insert Tools MWindow Help

=10] |

[X Y]=meshgrid(-2:0.2:2) lcemahars|o2pn
plot'o’f(')r(q,_Y,Z)

Z=X.*exp(-X."2-Y."2)
plot3(X,Y,2Z)

title(‘plot3(X,Y,2));
xlabel(*X")
ylabel(*Y”)
zlabel(‘Z’)

Meshgrid: NxM coppie di coordinate (X,y)

Introduzione a MATLAB

37




MATLAB: Visualizzazione

e E’possibile rappresentare delle superfici wireframe

) Figure No. 2 o m] 1

File Edit “iew Insert Tools Window Help

[X Y]=meshgrid(-2:0.2:2) lozaava r/sl2e0
mesh_(}f:(__,_Y,Z)

Z=X_*exp(-X.A2-Y A2)

title(‘'mesh(X,Y,2)); Z 0

xlabel("X’) | WZ/
ylabel('Y’) ==

zlabel(*Z")

Introduzione a MATLAB 38




MATLAB: Visualizzazione

 E’possibile rappresentare delle superfici solide

il <) Figure No. 3
File Edit Wiew Insert Tools Wwindow Help

=10l x|

[X Y]=meshgrid(-2:0.2:2) lczmarars 200
Surf(x,Y,2)

Z=X.*exp(-X."2-Y."2)
surf(X,Y,2)

title(‘surf(X,Y,2)");
xlabel(*X")
ylabel(*Y”)
zlabel(‘Z’)

Introduzione a MATLAB

39




MATLAB: Vis

e Curve di livello

[X Y]=meshgrid(-2:0.2:2)
Z=X.*exp(-X."2-Y ."2)

contour(X,Y,Z);




MATLAB: Vis

e Curve di livello

[X Y]=meshgrid(-2:0.2:2)
Z=X.*exp(-X."2-Y ."2)

contour3(X,Y,2);



MATLAB:

Visualizzazione

 Rendering

[X Y]=meshgrid(-2:0.2:2)
Z=X.*exp(-X.A2-Y.A2)
surf(X,Y,2)

shading interp

material metal
lightangle(45,45)

lighting phong

) Figure No. 1

Ele Edit Wiew Insert Tools Window  Help

lDzma xA 2/ ®p0

Introduzione a MATLAB
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MATLAB: Visualizzazione

* Visualizzare il contenuto di una matrice come una immagine

J Figure Mo. 1 ;|g|5|
File Edit Yiew Insert Tools Window Help
[X Y]=meshgrid(-2:0.2:2) los@a/yar/s|2po
Z=X.*exp(-X.2-Y.72) /C_) Bl &
.l | 0.3
imagesc(2) sl . 02
lorb | P
colorbar punto (-2,-2) 10}
della funzione ol T
14} 4-0.1
Riscala i1 valori della matrice
per rendere le differenze piu 16 r 0.2
visibili 18+
03
20F
v 0.4

20

Introduzione a MATLAB
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Programmazione

 M-File
— Permettono di definire una serie di operazioni che possono essere
eseguite in sequenza tramite chiamata
— Si possono utilizzare tutte le funzioni ed operatori
— E’ possibile creare nuove funzioni
— Possibile utilizzare diversi costrutti di controllo

If espressione while  espressi one
| struzi oni | struzi oni
elseif espressi one end
| struzioni
end

for vari abil e=i ni zi o: passo: fine
| struzi oni
end

Introduzione a MATLAB
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Programmazione

« M-File
— Per editare un m-file di puo eseguire il comando
edit m Of i I e- m Eilegdit ew Text Debug Breskpoints web Window  Hel el
Dm’:ilmgnw|§|ﬁf,@@%@@@|m:]e§e ~] x|

1
~~ Comandi di Debug ]

Finestra di editing

[seript

— Alcuni comandi MATLAB sono M-File
— | commenti (non esequiti) sono preceduti con %
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Programmazione: M-File

e Esitono due tipologie di M-File

script

function

Non ha argomenti di input
o di output

Ha argomenti di input e di
output (keyword function)

Le variabili sono nel
workspace globale

Le variabili interne sono
locali

Utile per automatizzare
una serie di passi ripetitivi

Utile per estendere le
funzionalita di MATLAB

Introduzione a MATLAB
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Programmazione: M-File

° Scri t <} Command Window Y m] A
p File Edit Yew Web ‘Window Help
B} C:\Programmi’,MATLAEGpS, wo - |I:I|i| s =
) 3 ] . 727 Undefined function or wariahle 'stato'.
File Edit YWew Text Debug Breakpoints Web
Window  Help Error in ==> C:\progrannitMATLARGpS\work'mioscript.m
; On line 7 ==> if{statao==0
DEE & ERo | 5 # fx ‘ ’
1 % Esempio di script = »» stato=0; *» Definisco la variabile
2 P2 mioscript nel workspace
3|- -pi:pi/l00:pi; et
4l - bin (%) ; &> mioscript
> L
al = cos(x): i
b d [
7|- || if(stato==0; \
al - plotix,s,x,c)
] else \
10] = plotic,s) L rorerod 1ol ol
1= end ﬂDiﬁﬁlé\kiA;/U;E? J]Diﬁiﬂé\kiA;/U;E?
1 1
08 08
06 06
= 04 04
-
0.2 0.2
1 [ i i
|script Lna Cal 8
04 04
06 0.6
A 4
08 -0.8
NB: sono nel workspace J M ; ‘
-4 3 2 K] 0 -1 08 06 04 02 O

globale
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Programmazione: M-File

 Function

B} C:\Programmi’,MATLABGDS Wi

=101 %]

File Edit YWew Text Debug Breakpoints Web
Window Help

L e = 2 e o L e

o

10
11
12
13

D@ E| 4R | & # Ffx

&

% ezempio di Function

unction out=myfunctistato]
-pi:pislO0:pi:
sin(=):
cos(x):

if (stato==0]
plotix,=z,x,C]
else
plotic,=s)
end
out=x;

>

ll_"’l ryllﬁ.funct.m | mioscript.m |

| myfunct Ln13

Cal 7

\ 4

NB: sono locali

<) Command Window

File Edit Wew ‘Web Window Help

=101 %]

N

Nome del file .m

722 Input arqument 'stato'! iz undefined.

Error in ==> CiiprogranmiyMaTLABepShworkymyfunct.m
O line 8 ==> if(stato==0]

»> stato=0;
= myfunct
772 Input argqument 'stato' iz undefined.

Error in ==> C:'\programmi‘\MATLAEGpS\workmyfunct.m
Onn line & ==> if(stato==0]

= a=myfunct(0) ;

=> whos
Name Size Bvtes Class
a 1x201 1608 double array
=tato 1x1 § double array

Grand total is 202 elements using l6le bytes

> |

4

|¥

g Ell
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Programmazione: M-File

 Function

% funzione con un solo valore di output
function res=none_funzi one(paranetri)

% funzione con diversi valori di output
function [ resl,res2,res3]=none_funzione(paranetri)

% funzione senza valori di output
function none_funzi one(paranetri)

 Possono essere definite variabili globali
global none _variabile

* Possono essere definite piu funzioni ma
— La funzione associata al file .m € la prima

Introduzione a MATLAB
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Programmazione: M-File

* Input da tastiera

% input generico
res=input(" Inserisci un numero );

% input di una stringa
res=input(  Nome del file: ')'S’);

e Performance
— Evitare il piu possibile cicli for
— MATLAB e ottimizzato per operazioni matriciali
— Fare molte operazioni matriciali € piu veloce che fare un solo ciclo

N=M+10.*(not(M==0))+5.*(M==0)

Introduzione a MATLAB
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Elaborazione numerica deil segnali

* Creazione di funzioni all'interno di m-files per la costruzione

di alcuni tipi di segnali elementari a tempo discreto

e Esercizi

Introduzione a MATLAB
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Segnall elementari a tempo discreto

« IMPULSO

function [X,n]=impulso(a,b,n0)

% genera x(n)=delta(n-n0), a<=n<=b
n=a:b;

x=double([(n-n0)==0]);

>>[x,n]=impulso(-10,10,3);
>>stem(n,X)

1

0.9

0.8+

0.7+

0.6-

0.5¢

0.4r

0.3

0.2+

0.1r

mmmmmmmmm

s
-0 -8 -6 4 2 0 2 4 6 8 10
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Segnall elementari a tempo discreto

« GRADINO

function [X,n]=gradino(a,b,n0)
% genera x(n)=u(n-n0), a<=n<=b
n=a:b;

x=double([(n-n0)>=0]);

0.9

0.8+
0.7r

0.6-

>>[x,n]=gradino(-3,12,2); o8|
>>Stem(n,x) 04|

0.3r
0.2+

0.1r
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Segnall elementari a tempo discreto

« FINESTRA

function [X,n]=finestra(a,b,n0,n1)
% genera x(n)=u(n-n0)-u(n-nl), a<=n<=b
n=a:b;

x=double((n-n0)>=0) - double((n-n1)>0);

0.9r

0.8+
0.7r

0.6-

>>[x,n]=finestra(-10,10,-5,0); 05
>>Stem(n,x) 04l

0.3r
0.2+

0.1r
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Segnall elementari a tempo discreto

« RAMPA

function [X,n]=rampa(a,b,n0)
% genera x(n)=n, a<=n<=b
n=a:b;

x=(n-n0).*double((n-n0)>=0);

>>[x,n]=rampa(-5,10,2);
>>stem(n,X) i I

10

Segnali elementari a tempo discreto
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Segnall elementari a tempo discreto

 SINUSOIDE

function [X,n]=sinusoide(A,f0,phi,a,b)
% genera x(n)=A*sin(pi*fO*n+phi)

n=a:b;
x=A*sin(pi*fo*n-+phi): Joer o]
>>[x,n]=sinusoide(1,1/8,0,0,20); 02 T T T
>>stem(n,x) i i l '

; o

1 ! ! ! ! ! ! ! !
0 2 4 6 8 10 ° 14 16 18 20
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Esercizio #1

« Datii segnali analogici

X, (t) = cos(20rt)
X, (t) = cos(1007t)
campionati con frequenza di campionamento F.=40Hz, determinare |

corrispondenti segnali campionati e disegnarli. Determinare infine |
corrispondenti segnali ricostruiti.

Esercizio #1
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Esercizio #1

e Soluzione
X (n) = cos(g nn) = (:os(1 nn) = cos(1 Zﬂnj
40 2 4
X,,(Nn) = cos(1007zt) = co{% ﬂnj = co{g ﬂnj = CO{[Z]T+ % 7T:| nj = co{% ﬂnj = co{% ij

Frequenza normalizzata = ¥ cycles/sample, !
ovvero 4 samples/cycle 08}

e Segnali ricostruiti

X (1) = X5 (1) = cos(% 40nt] = cos(2071t)

Esercizio #1 - Soluzione 59




Esercizio #2

« Datii segnali analogici

X, (t) = cos(20rt)
X, (t) = cos(1007t)
campionati con frequenza di campionamento F,.=50Hz, determinare |

corrispondenti segnali campionati e disegnarli. Determinare infine |
corrispondenti segnali ricostruiti.

Esercizio #2
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Esercizio #2

e Soluzione

20 2 1 Frequenza normalizzata = 1/5 cycles/sample,
%(n) = CO{@ ””j = COS(_ ””j = Co{g 277”) ovvero 5 samples/cycle

X, (n) = cos(1007t) = cos(

1

5
100

= ﬂnj = cos(27m) = cos(0n) =1

Frequenza normalizzata = O cycles/sample

0.8-

0.6-

0.4r

1] ]

[ ]

P X

0.9-

0.8-

0.7-

0.2+

-0.4F

-0.6

-0.8+

-1

[

0.2r

0.1-

I I
0 2 4

» Segnali ricostruiti

I I
6 8

Xa1

I I I I I 0 . I 1 I I
10 12 14 16 18 20 0 2 4 6 8 10 12 14 16 18 20

(t) = co{é SOm] = cos(2071t)

X,,(t) = cos(0507t) = cos(Omt) =1

Esercizio #2 - Soluzione
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